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1. Introducción
En la antigüedad se creía en la inmutabilidad del firmamento. Con el término de estrellas fijas se designaba a los objetos que, aparentemente, no cambiaban de posición en la esfera celeste. Así, se podían distinguir de otros cuerpos como la Luna y los planetas, que sí seguían un movimiento y evolución en el cielo. En este caso práctico veremos que las estrellas fijas no están realmente tan fijas.
Existen diferentes razones para explicar el cambio de posición de una estrella en el cielo. Por un lado, hay cambios aparentes debido al movimiento de la Tierra alrededor del Sol, lo que se denomina paralaje astronómica y a la velocidad finita de la luz (aberración).
Por aparente queremos decir que la estrella parece que se mueve, pero en realidad no es así. En el caso de la paralaje, por ejemplo, es la Tierra la que realmente se mueve. Y, por otro lado, existen también variaciones reales en la posición de las estrellas debido a su movimiento propio.
 1  Movimiento propio
Entendemos por movimiento propio la variación real de la posición de una estrella en el cielo debido al movimiento relativo entre ella y el Sol (véase figura 1).
Es una medida del desplazamiento verdadero de la estrella con respecto al Sistema Solar y está producido por la rotación de las estrellas alrededor del centro de nuestra galaxia.
[image: Imagen que contiene luz, colgando, oscuro, alambre
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El movimiento propio viene dado por la siguiente expresión:
    (1)
  
donde
    (2a)

      (2b)

indican los desplazamientos angulares en las coordenadas de la ascensión recta (α) y la declinación (δ), respectivamente.
Así, el movimiento propio nos indica la distancia angular que recorre la estrella en un año y se suele medir en segundos de arco por año.
      (3)
 2  La estrella de Barnard
La estrella de Barnard, llamada también como V2500 Oph, es la estrella conocida con mayor movimiento propio, con 10,358"/año [1] (véase figura 2). Se encuentra muy cerca de la Tierra, a 5,9 años luz. Tan solo el Sol y las tres componentes de Alfa Centauri están a una distancia menor de la Tierra. Tiene una masa de 0,15 masas solares [2], y una temperatura superficial de 3223 K [2], menos que el Sol que tiene 5700 K, y una luminosidad 2500 veces inferior a la del Sol [3]. En tamaño, la estrella de Barnard es comparable al planeta Júpiter, siendo mucho más pequeña el Sol (véase figura 3). A este tipo de estrellas se les denomina enanas rojas y se sitúan muy por debajo de la posición del Sol en el diagrama H-R [4] (véase figura 4).
[image: At last, a planet for Barnard's Star | Space | EarthSky]Figura 2. Movimiento propio la estrella de Barnard. Se muestra la estrella observada desde 1991 hasta 2007. Fuente: One-Minute Astronomer.

[image: Interfaz de usuario gráfica, Aplicación

Descripción generada automáticamente]Figura 3. Tamaño a escala del Sol, la estrella de Barnard y Júpiter.

[image: The Hertzsprung-Russell Diagram.]Figura 4. Diagrama H-R donde se muestran la estrella de Barnard y el Sol.


 3  Herramienta del Observatorio Virtual requerida: Aladin
Aladin es un potente atlas interactivo del cielo, desarrollado y mantenido por el Centro de Datos astronómicos de Estrasburgo (CDS), que permite al usuario visualizar imágenes de cualquier parte del cielo y superponer datos de tablas y catálogos de diferentes archivos astronómicos.
Para la instalación, simplemente, se tiene que acceder a los enlaces mostrados a continuación y descargarlos en el escritorio o la carpeta que se vaya a usar en este caso práctico.
Aladin es una aplicación Java que se puede descargar gratuitamente entrando en la siguiente página web: 
https://aladin.cds.unistra.fr/
Para la realización de esta práctica vamos a utilizar la versión Aladin.jar 11.0 que está disponible en el siguiente enlace:
https://aladin.cds.unistra.fr/java/Aladin11.0.jar
NOTA: se utilizará una versión sin necesidad de un entorno de Java en formato de ejecutable directamente, pero cualquier otra versión tendrá el mismo funcionamiento.
 4  Desarrollo del caso práctico
 4.1  Abrir Aladin y cargar la imagen de la estrella de Barnard
Una vez instalado, abrimos Aladin, que estará en el directorio en el que se ha descargado previamente. Para poder calcular el movimiento propio, debemos escoger dos imágenes tomadas en épocas diferentes. Para ello, en la pestaña superior central de Command escribimos Barnard Star (véase figura 5), pulsamos Enter y haremos lo siguiente en la ventana principal de Aladin (véase figura 6):
View → Panels → 4 panels (Mayús + F2)
En la imagen superior izquierda se podrá acercar y alejar la vista con la rueda del ratón.
[image: Interfaz de usuario gráfica, Sitio web

Descripción generada automáticamente]Figura 5. Ventana principal de Aladin.


[image: ]Figura 6. Ventana principal de Aladin.


La imagen que se carga automáticamente corresponde al Digitized Sky Survey 2 (DSS 2 color, véase figura 7). Este survey, producido por el Space Telescope Science Institute (STScI), contiene imágenes tomadas por el AAO (Australian Astronomical Observatory), el Observatorio Palomar y el HST (Hubble Space Telescope), que cubren la totalidad del cielo [5].
[image: Captura de pantalla de computadora

Descripción generada automáticamente]Figura 7. Lista de surveys y visor de Aladin.


Volviendo a la imagen del panel situado en la parte superior izquierda, se puede ver que aparecen dos puntos, naranja y azul, que corresponden a la imagen de la estrella de Barnard, tomada en dos momentos diferentes.
Para reconstruir esta imagen y poder calcular el movimiento propio de la estrella entre las dos épocas, se procede de la siguiente forma:
1º/ Abrimos el selector de servidores (véase figura 8):
File → Open server selector… (CTRL + L)
2º/ En la ventana del selector, pulsamos sobre la opción DSS (from STScI) de la barra izquierda.
3º/ Escribimos el nombre de la estrella en la pestaña de Target (ICRS, name), seleccionamos el Sky Survey de POSS2UKSTU_Red y una altura y anchura (Height y Width) de 6 arcmin en ambas.
[image: ]Figura 8. Ventana del selector de servidores.


[image: ][image: Interfaz de usuario gráfica, Aplicación
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4º/ Sobre el panel superior derecho, se pulsa clic derecho y se bloquea la vista en Locked view.
5º/ Se pulsa con clic izquierdo en el panel inferior izquierdo y se repiten los pasos del 1 al 4, cambiando el Sky Survey del punto 3 por el survey POSS2UKSTU_Blue (véase figura 9).
Estos dos survey del DSS corresponden al Palomar Observatory Sky Survey, una colección de placas fotográficas digitalizadas que cubren todo el cielo accesible desde el Observatorio de Monte Palomar, desde +90 a -27 grados de declinación, y en distintas zonas del espectro electromagnético, o color.
 4.2  Generador de Película
Aladin permite combinar las dos imágenes en una película para confirmar si la estrella se ha desplazado. Para ello haremos lo siguiente en la ventana principal de Aladin:
Image → Blink/Movie generator…
[image: Interfaz de usuario gráfica

Descripción generada automáticamente]Figura 9. Visor de Aladin mostrando las 3 imágenes.


En la ventana de asociación de imágenes (véase figura 10), se seleccionan en las dos primeras celdas las dos imágenes de la estrella de Barnard tomadas por STScI, y elegimos el delay (o retraso) con el que queremos verlas, por ejemplo, 1600 milisegundos. A continuación, hacemos clic en create para generar la película, que se creará en el cuarto panel del visor.
[image: Captura de pantalla de computadora
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[image: ][image: Imagen en blanco y negro
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Se puede apreciar claramente el movimiento de la estrella de Barnard frente al fondo de estrellas fijas. Si no se activa la visualización de la película, se puede usar el deslizador que aparece sobre la imagen de la misma (véase figura 11).
[image: Captura de pantalla de computadora

Descripción generada automáticamente]Figura 11. Visor de Aladin donde aparece un frame de la animación donde se puede comprobar que la estrella se mueve entre las dos posiciones de las dos imágenes utilizadas.

 4.3  Medida de la distancia angular entre las dos épocas
Para medir la distancia que se ha movido la estrella de Barnard procederemos de la siguiente manera.
Seleccionamos el icono dist en la opción que aparece en la barra de herramientas vertical de la derecha del visor de Aladin (véase figura 12). A continuación, en la imagen superior izquierda haciendo zoom para ver mejor la imagen, tenemos que comprobar que las imágenes naranja y azul de la estrella corresponden con las dos posiciones de las dos imágenes del DSS, pulsamos con el clic izquierdo sobre el centro de la estrella y volvemos a pulsar en el centro de la estrella del otro color. Aparecerá una flecha que nos indicará la distancia angular entre ambas posiciones, aproximadamente 32 segundos de arco (véase figura 13). Además, la medida de distancia angular que se ha realizado en la primera imagen (superior izquierda) se verá también en el resto de las imágenes.
[image: Interfaz de usuario gráfica, Texto, Aplicación

Descripción generada automáticamente]Figura 12. Herramienta de distancia.

[image: Pantalla de computadora

Descripción generada automáticamente]Figura 13. Zoom en la imagen de DSS2 color donde aparecen las dos imágenes de la estrella de Barnard en dos épocas distintas.

 4.4  Cálculo del movimiento propio
Para calcular el movimiento propio pulsaremos con el botón derecho sobre cada una las imágenes POSII y pulsamos en la opción Properties.
Así, se abre la ventana de propiedades que contiene información sobre las imágenes en la que se realizó cada una de las observaciones. Habrá que hacerlo para las dos imágenes de la estrella de Barnard (véase figura 14).
[image: Una captura de pantalla de una computadora

Descripción generada automáticamente]Figura 14. Ventanas de propiedades de los dos planos de las imágenes.

En las ventanas de propiedades, hacemos clic en Get original header para que Aladin nos muestre en una ventana nueva la información de las imágenes. Ahí se podrá ver, en cada una de las imágenes, en la fila de DATE-OBS la fecha de observación, de manera que tendremos que para la imagen azul la fecha es 1988-05-12 y para la imagen roja la fecha es 1991-06-16, en formato año/mes/día (véase figura 15).
Para transformar las fechas a formato decimal, se calcula mediante la siguiente expresión:

Obtenemos así las fechas 1988,36347032 y 1991,45776256, respectivamente, lo que da una diferencia de 3,09429224 años. El 1 de la expresión anterior, que se resta en los días y los meses, está para obtener el año exacto a fecha de 1 de enero.Figura 15. Header del archivo de la imagen roja.

[image: Interfaz de usuario gráfica, Aplicación

Descripción generada automáticamente]Figura 16. Herramienta de selección.

Finalmente, para calcular el movimiento propio de la estrella de Barnard haremos uso de la expresión (3):

resultando en un movimiento propio de 10,312” por año.
Comparemos, a continuación, este valor con el que aparece en la base de datos de SIMBAD. Para ello haremos lo siguiente en la ventana principal de Aladin: en la pestaña inferior izquierda, donde aparece select, escribimos simbad. Esto mostrará, en la parte izquierda de la ventana de Aladin, una lista de bases de datos. Pulsamos sobre la tercera línea en SIMBAD Astronomical Database y cargamos la base de datos.
[image: ][image: ]
En los paneles aparecerán una serie de iconos por encima de la estrella. Seleccionamos la herramienta de select (véase figura 16) y en el primer panel arrastramos con el cursor para abarcar los iconos de la parte central de la imagen.
[image: ]
Aparecerá en la parte inferior una tabla donde, en la columna MAIN_ID, se podrá leer NAME Barnard’s star y GJ 699 b (un candidato a exoplaneta detectado orbitando la estrella de Barnard). Si desplazamos la barra inferior hacia la derecha, podemos leer las columnas de PMRA y PMDE, y que corresponden a las componentes del movimiento propio en ascensión recta y declinación, respectivamente. Junto con el dato de la declinación, en la columna DEC, y haciendo uso de la expresión (1), se puede calcular el siguiente valor para el movimiento propio de la estrella de Barnard, teniendo en cuenta que hay que dividir por 1000 para pasar de milisegundos de arco a segundo de arco:
10393.1415892 mas/año = 10.393”/año
Vemos como el valor de SIMBAD es muy similar al que hemos obtenido con Aladin.
 4.5  Cálculo de la velocidad de la estrella de Barnard
SIMBAD también proporciona información sobre la paralaje de la estrella de Barnard, la cual tiene un valor de 546,9759 milisegundos de arco [1]. Para poder ver esa información, se debe pulsar sobre el nombre de la estrella (en la columna MAIN_ID), lo que nos redirigirá a la página web de SIMBAD (véase figura 16). Conociendo la paralaje podemos calcular fácilmente la distancia a la que se encuentra a partir de la siguiente expresión:


Donde 1 pársec equivale a 3,26 años luz o, lo que es lo mismo, a la distancia que recorre la luz en 3,26 años, igual al valor de distancia de 30.856.802.500.000 kilómetros.
Asimismo, debemos transformar el movimiento propio de segundos de arco/año a radianes/año a partir de la siguiente fórmula:
1 rad = 206265”


Por tanto, la distancia recorrida por la estrella de Barnard en un año viene dada por la siguiente expresión:

Equivalente a 2830735813 km en un año, o lo que es lo mismo, a una velocidad de 89,76 km/s.
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“100 conceptos básicos de Astronomía”
https://www.sea-astronomia.es/sites/default/files/100_conceptos_astr.pdf

Para saber más sobre:
· Observatorio Virtual:
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NOTA:
Si hace uso de esta guía, por favor, incluya la siguiente frase de agradecimiento en cualquier tipo de publicación o presentación:
"Esta publicación / presentación ha hecho uso de las guías educativas de Observatorio Virtual originalmente desarrolladas en el marco del proyecto EuroVO-AIDA (INFRA-2007-1.2.1/212104) y actualizadas en el marco del proyecto PID2020-112949GB-I00 financiado por: MCIN/AEI/10.13039/501100011033/"
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Hertzsprung-Russell Diagram
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Aladin Sky Atlas -v11.0
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4 Aladin comesponden a la imagen de la estrella de
Barmard, tomada en dos mometos diferentes

Para la instalacién, simplemente, se tiene que 5.2 Generador de Pelicula

acceder a los enlaces mostrados a continuacién

¥ descargarlos en el escritorio o la carpeta que s

Para reconstruir esta imagen, y poder calcular el

Aladin permite combinar las dos imégenes en
‘movimiento propio de la estrella entre los dos

una pelicula para confirmar si la estrella se ha

Blue (X45) “aya a usar en este caso prictico. procede de la siguiente forma: desplazado. Para ello haremos Io siguiente en Ia
ored ventana principal de Aladin

DSS2Red (F4R) Aladin es un potente atlas interactivo del cielo,

DSS2NIR (+15) desarrollado y mantenido por el Centro de Datos ) © Imagen — Generador de Animacién/

astronémicos  de  Estrasburgo  (CDS), que o - Pelicula. Escogemos aquella que queremos

| Decal
% Melinger

| PHAS

permite al usuario visualizar imdgenes de
cualquier parte del cielo y superponer datos de
tablas y catdlogos de diferentes archivos
astronémicos.

Aladin es una aplicacién Java que se puede
descargar gratuitamente entrando en la siguiente
pégina web:

Figura 5. Pégina de Aladin.

Escribimos el nombre de la estrella en la
pestasia de Target (ICRS, name), sc!

uvey, de POSSJUKSTU_Red
altura por anchura (Height y Widdh) de 6 ascmia
en ambas

ver en primer y en segundo lugar (figura 9).
—Hacemos "click” en "CREAR"

Se puede apreciar claramente el movimicato de
la estrella de Barnard frente al fondo de estrellas
fijas. Para detener la animacién simplemente
habria que climinar el “fick” del plano “Blis

(uy, 2 g
MINI-PAS-PDR20191 ecember ity ladin cds.unistra fr/ me
i Bass — 2 Para la realizacién de esta practica vamos a U CURE - 5.3 Medida de la distancia angular
@ ¥ DES DR1LIneA color 1 &3 STScl POSS2UKSTU_Blue 17:57:48.49847 +04 utilizar la én Aladinjar 110 que esta Figura 6. Pdgina de Aladin e Ogtad oS o ST ) O entre las dos épocas
G S & &3 STScl PC ¢ disponible en el siguiente enlace: El survey utilizado de forma predeterminada es e — Para medir la distancia que se ha movido la
—~ nfrared - i e st £y v/ Aladinl 10 $S2 color. Este guzvey se ha producido por el e estrella de Barnard procederemos de la siguiente
Radio https-//aladin.cds unistra fi/java/Aladinl 1.0 jar (Sace Telescape Sciance Institute) entre == manera
s-ines § A . . 1998 con imagenes tomadas por el AAO |
¥ Data base NOTA: se uillizarh una versibn sinnecesidad de L ronamical Qbseovaters). €l En la ventana principal de Aladin:
un entomo de Java en formato de jecutable Qhservatan).
I Catalog e ; ormato d € Observatorio Palomar y el HST (Hubble Space .
g irectamente, pero cualquier otra versién tendrd > Sa o Imagen — Creador de imagen RGB (figura
. Cube e fo e oty lescape). que cubren la totalidad del cielo [3] e
I Andilar - Como se puede comprobar a la izquierda del 0L . .
| Outreach visor de Aladin, dentro del catélogo DSS de Si apretamos el botén "CREAR" apareceran las
Others 5 Desarrollo del caso practico imdgenes, ademas de estar seleccionada la dos imdgenes superpuestas. Las estrellas cuyo
- ;_,;_,‘,A,_ 3 opeién de DSS color, aparecen las opciones de movimiento propio es despreciable apareceran

(L - all collections — =l

5.1 Abrir Aladin y cargar la imagen de
la estrella de Barnard

Unavez instalado, abrimos Aladin, que estaré en

el directorio en ¢l que s ha descargado

previamente

2 Blue (XF+S), DSS2 Red (F+R) y DSS2
NIR (XI+IS), que corresponden con imagenes
tomadas en distintas zonas del espectro
clectromagnético, concretamente, el espectro

le (las dos primeras en longifudes de onda

en blanco, mientras que la superposicién de las
dos imégenes coloreadas provocard que en una
posicién la estrella de Bamard aparezca en
naranja y en la otra en azul (figura 11).

A continuacién, haremos un “zoom™ de la

m tay rojas, respectivamente) y en el espectro
NG infraroro corcatie al visible imagen para medir la distancia angular entre
sort view Para poder calcular el movimiento propio, ) ciones. Para cllo scleceionaremos la
debemos escoger dos imégenes tomadas en inferior izquierdo y se repiten los pasos 1, 2, 3 s n el meni desplegable de
(c) 2022 Université de Strasbourg/CNRS - developed by CDS, distributed under GPLY3 0sel/0src1000fps /588Mb dnncas Dara olln an la mectaia ERROIC Y N BRI
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5 Fuente

aswonomicos ae Eswasourgo (LUS), que
permite al usuario visualizar imdgenes de
cualquier parte del cielo y superponer datos de
tablas y catdlogos de diferentes archivos
astronémicos.

Aladin es una aplicacién Java que se puede
descargar gratuitamente entrando en la siguiente
pégina web:

Para la realizacién de esta prictica vamos a
utilizar la versién Aladinjar 11.0 que estd
disponible en e siguiente enlace:

NOTA: se utilizard una versién sin necesidad de
un entorno de Java en formato de cjecutable
directamente, pero cualquier otra versién tendrd
el mismo fancionamiento.

5 Desarrollo del caso practico

5.1 Abrir Aladin y cargar la imagen de
la estrella de Barnard

Unavez instalado, abrimos Aladin, que estaré en

el directorio en ¢l que s ha descargado

previamente

Para poder caleular el movimiento  propio,
debemos escoger dos imégenes tomadas en
épocas diferentes. Para cllo, en la pestaia
superior _central de  Command escribimos
Barmard’s Star (véase figura 5), pulsamos

Enter y haremos lo siguiente en la ventana
principal de Aladin (véase figura 6)

View — Panels — 4 panels (Maviis + F2)

En la imagen superior izquierda se podré realizar
za0m

Espaiiol (Espaiia)

B Q Bisqueda

 Accesivilivad: e necesari investigar

Figura 5. Pégina de Aladin.

Figura 6. Pégina de Aladin.

El syryey utilizado de forma predeterminada es
DSS2 color. Este surxgy se ha producido por el
STScl (Space Telescope Science Institute) entre
1975 y 1998 con imégenes tomadas por el AAO
(dustralian  dstronomical Qbservatery). el
Observatorio Palomar y el HST (Hubble Space
Talescape). que cubren la totalidad del cielo [5].
Como se puede comprobar a la izquierda del
visor de Aladin, dentro del catdlogo DSS de
imdgenes, ademds de estar seleccionada la
opcién de DSS color, aparecen las opciones de
DSS2 Blue (XJ+S), DSS2 Red (F+R) y DSS2
NIR (XI+IS), que corresponden con imégenes
tomadas en distintas zonas del espectro
electromagnético, concretamente, el espectro
visible (las dos primeras en longitudes de onda
violeta y rojas, respectivamente) y en el espectro
infrarrojo cercano al visible.

Figura 7. Lista de suryeys y visor de Aladin.

Volviendo a la imagen del panel situado en la
parte superior izquierda, se puede ver que
aparecen dos puntos, naramja y azul, que

Titulo

Estilos

T

2%/ En la ventana del selector, pulsamos sobre la
opeién DSS de la barra izquierda.

3 Escribimos el nombre de la estrella en la
pestatia de Target (ICRS, name). seleccionamos
el Sky Survey de POSS2UKSTU_Red y una
altura por anchura (eight y Widsh) de 6 ascmia
en ambas

PN
B e o T —

P

i o

&

Figura 8. Ventana del selector de servidores.

susmIT

4%/ Después, sobre el panel superior derecho, s
pulsa clic derecho y se bloquea la vista en

Locked view.

5%/ Se pulsa con clic izquierdo en el pancl
inferior izquierdo y s repiten los pasos 1,2,3 y
4, cambiando el Shy Survey, del punto 3 por el
‘survey POSS2UKSTU_Red.

Estos dos suvgy del DSS coresponden al
Palomar Qbservatery Sk Survey una coleccién
de placas fotograficas digitalizadas que cubren
todo el cielo accesible desde el Observatorio de
Monte Palomar, desde +90 a -27 grados de
declinacién, y en distintas zonas del espectro
clectromagnético, o color.
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Figura 9. Visor de Aladin mostrando las 3
imégenes.

5.2 Generador de Pelicula

Aladin permite combinar las dos imégenes en
una pelicula para confirmar si la estrella se ha
desplazado. Para ello haremos lo siguiente en la
ventana principal de Aladin

Iimage — Blink Movie geugrator.

Se puede apreciar claramente el movimiento de
la estrella de Barnard frente al fondo de estrellas
fijas. Para detener la animacién simplemente
habria que climinar el “fick” del plano “Bli;
me

5.3 Medida de la distancia angular
entre las dos épocas
Para medir la distancia que se ha movido la

estrella de Barnard procederemos de la siguiente
manera

En la ventana principal de Aladin:

© Imagen — Creador de imagen RGB (figura
10)

Si apretamos el botén "CREAR" aparecerdn las
dos imégenes superpuestas. Las estrellas cuyo
movimiento propio es despreciable aparccerdn
en blanco, mientras que la superposicién de las
dos imégenes coloreadas provocard que en una
posicién la estrella de Bamard aparezca en
naranja y en la otra en azul (figura 11).
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Fig8. Imdgenes cargadas en Aladin

POSS son las siglas de Palomar Observatory
Sky Survey, uma coleccién de placas
fotograficas digitalizadas que cubren todo el
cielo accesible desde el Observatorio de Monte
Palomar (desde +90 a -27 grados de
declinacién).

5.4 Generador de Pelicula

Aladin permite combinar las dos imagenes en
una pelicula para confirmar si la estrella se ha
desplazado. Para ello haremos lo siguiente en la
ventana principal de Aladis

o Imagen - Generador de Animacién

Pelicula. Escogemos aquella que queremos
ver en primer y en segundo lugar (figura 9).

Q Bisqueda

plano “Blk img”.

5.5 Medida de la distancia angular
entre las dos épocas

Para medir la distancia que se ha movido la
estrella de Barnard procederemos de la
siguiente manera.

En la ventana principal de Aladin:

Imagen — Creador de imagen RGB (figura
10) .
Si apretamos el botén "CREAR" aparecerdn las
dos imédgenes superpuestas. Las estrellas cuyo
movimiento propio es despreciable apareceran
en blanco, mientras que la superposicion de las

Generador de imagen RGB
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Fig10. Generador de la imagen compuesta.
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5 Fuente 5

Se puede apreciar claramente el movimiento de
la estrella de Barnard frente al fondo de estrellas
fijas, arrastrando el deslizador rojo de la parte
superior del panel inferior derecho donde
apareceré la animacién.

Figura 11. Visor de Aladin donde aparece un
framg intermedio de la animacion donde se
puede comprobar que la estrella se mueve entre
las dos posiciones de las dos imdgenes
wilizadas.

5.3 Medida de la distancia angular
entre las dos épocas

Para medir la distancia que se ha movido la
estrella de Barnard procederemos de la siguiente
manera

Pulsamos en la opeién que aparece en la barra e
herramientas vertical de la derecha del visor
donde pone gist, A continuacién, en la imagen
superior  izquierda, donde tenemos que
comprobar que las imégenes naranja y azul de la
estrella corresponden con las dos posiciones de
las dos imégenes del DSS, pulsamos con el clic
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Figura 12. Zoom en la imagen de DSS2 color
donde aparecen las dos imégenes de la estrella
de Barnard en dos épocas distintas.

Asi, aparccerd una nueva ventana llamada de
propiedades que contiene informacién sobre las
imégenes en la que se realizé cada una de las
observaciones. Habré que hacerlo para las dos
imégenes de la estrella de Barnard.

Figura 13. Ventanas de propiedades de los dos
planos de las imégenes.

En las ventanas de propiedades, hacemos clic en

Titulo 1 o2 Titulo
tios
Q Pl 23 A s 6 '

Obtenemos asi las fechas 1988,36347032 y
1991,45776256, respectivamente, lo que da una
diferencia de 3,09429224 afios. El 1 de la
expresion anterior, que se resta en los dias y los
meses, estd para obtener el afio exacto a fecha de
1 de enero.

Finalmente, para calcular el movimiento propio
de la estrella de Bamard haremos uso de la
expresion siguiente expresién:

31,91"
3,09429224 aiios

resultando en un movimiento propio de 10,312"
por afio.

Comparemos, a continuacién, este valor con el
que aparece en la base de datos de SIMBAD.
Para cllo haremos lo siguiente en la ventana
principal de Aladin:

Aschivo — Cargar catdlogo— Simbad dafabass,

o Simamos el cursor sobre la ctiqueta “BY
Dsa” y hacemos “click”. En caso de que no
se visualice dicha ctiqueta debemos clegir
"zoom 1x". En la parte inferior de la ventana
principal de Aladin aparecerd una tabla con
informacién del objeto V* V2500 Qph, que
es ofro de los nombres que posee la estrella
de Barnard (figura 14)

© Hacemos “click” en el nombre del objeto
(V* V2500 Qph). Se abrié una ventana en
‘nuestro navegador mostrando la informacién
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Vemos como el valor de SIMBAD es muy
similar al que hemos obtenido con Aladin.

5.5 Calculo de la velocidad de la
estrella de Barnard

SIMBAD también proporciona  informacién
sobre la paralaje de la estrella de Barnard, la cual
tiene un valor de 0,549 segundos de arco.
Conociendo la paralaje podemos calcular
ficilmente la distancia a la que se encuentra a
partir de la siguiente expresién:

1

d

549 = Lbzpirsecs

1 pérsec equivale a 3,26 afios luz 0, lo que es lo
‘mismo, a 30.856.802.500.000 kilémetros.

Asimismo, debemos transformar el movimiento
propio de segundos de arco/aiio a radianes/afio a
partir de la siguiente formula:

1rad = 206265"

10,34 /206265 = 0,

Por tanto, la distancia recorrida por la estrella de
Barnard en un afio viene dada por la siguiente
expresion

R=d-u=182+0,00005013 =
0,0000912pérsecs = 2815253km.

Para saber mas sobre:
© Diagrama HR
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